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User Basics
Starting TrainingRegister
Select the shortcut on your desktop or go to the Windows Start Menu, select Programs,
then click on TrainingRegister. The icon is a vertical stack of books.
Login
Select [User Login] on the [File] menu or open a table from the [Tables] menu and you
will be prompted for your login information. Automatic login is also available (see
section “Security Settings”). To open the Sample database or a new empty database,
enter "1234" and "TEMP" for user ID and password. Otherwise enter the user ID and
password assigned to you for use with TrainingRegister. These values are not case
sensitive.
Opening a Training Database
The database is automatically opened when TrainingRegister is started. The data
cannot be accessed until the user logs in.
Reminders
When logging into TrainingRegister® a prompt with the option to check reminders is
displayed. If you choose [Yes], this feature will check for unposted scheduled classes
and display the number of scheduled classes with enrollment records that need posting.
TrainingRegister® Updates
Updates can be accessed from the [File] menu. Users will be directed to a web site that
will provide information regarding any changes, upgrades, or notices.
Tables Menu
All tables/forms are initially opened from the [Tables] menu. Select [Tables] and then
the name of the table you wish to open. To close a table, select the Close button located
on the bottom of each table/form.
Reports Menu
All reports can be found on the [Reports] menu. Selected reports can be found on the
[Reports] tab of various tables/forms. Upon selecting a report you will be prompted to
choose several options that affect the final report. The report will be displayed in your
web browser in a table format.
Messaging Menu
The [Messaging] menu is used for sending messages and attachments to most any group
of people in the People table (see section titled “Messaging” for detailed information
about this feature). Note: The [Messaging] menu is visible only if
EnableMAPI_Messaging is checked on the General Options form in the Configuration
tables.
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Tools Menu
The [Tools] menu has many tools available for upkeep and maintenance of the software.
The functions are described in more detail throughout this document.
Window Menu
Once tables are open, you can use the [Window] menu to switch back and forth between
the opened tables.
Time Saving Shortcut Keys
Shortcut Keys are keystrokes for power users who feel slowed down when they have to
reach for the mouse. Holding down ALT and then pressing the underlined character can
activate any button or menu item with an underlined character. Several shortcut
keystrokes are outlined in the section "Navigating/Editing Training Records".
Quitting TrainingRegister
Click [Save] or [Cancel] on any form that is being edited. To logout of
TrainingRegister, select [File], [User Logout]. Exiting TrainingRegister will also
perform a logout.
Getting Help/Training
Many forms have Instructions displayed to assist the user. More detailed instructions are
provided in this User Documentation which can be accessed from the [Help] menu.
Contact your internal support person. This will most likely be the Training Administrator
responsible for the TrainingRegister database, your Database Administrator (DBA), or
IT staff. These individuals work closely with the TrainingRegister vendor and are
trained to provide you with internal user support. They can set or reset your password and
access privileges as needed. These individuals are responsible for backing up and
compacting the database on a regular basis and can restore or repair the training records
database should it become corrupted.
Contact the TrainingRegister vendor for technical support or training. Contact
information can be found on the Help menu and on the vendor's website.
http://www.chriscollins.com Phone support: (316) 942-4339

Novice, Advanced & Expert User Levels
Currently TrainingRegister® provides three personal user levels to control helpful or
instructional messages and these levels might be used in the future to affect functionality.
The three levels are Novice, Advanced and Expert.
Novice Level Messages can be very helpful to a new user but might be very annoying to
an advanced or experienced user. An example of a Novice Level Message is the one that
is displayed when the first table/form is selected from the [Tables] menu. It tells the user
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they can open multiple forms and switch between forms using the Window menu. Most
users will want to turn off the Novice Level Messages as soon as they gain proficiency
with TrainingRegister. This can be done by setting the user level to “Advanced”.
If a message is controlled by one of the three personal user levels it can be identified as
such in its title bar. Example: The title bar of the message box reads “TrainingRegister
Novice Level Message”.
TrainingRegister® provides two ways to set the User Levels. 1) From the [Tables] menu
select [Configuration Tables], [Personal Options], [User Level] to set or change the
default level for the current user. 2) Temporarily change the User Level by selecting
[File], [User Level Toggle].

Navigating/Editing Training Records
Database Navigation buttons are found in the bottom left area of each data form.
Hovering the mouse pointer over each button will reveal a tool tip describing its function.
Not all buttons are available on every form. A but ton may be dim, invisible or
intentionally disabled.
Directly above the navigation buttons a message will display the number of records
retrieved from the database or database server. To retrieve records use the [Find] button.
Shortcuts are identified by an underlined letter such as the "F" on the [Find] button.
[Find] permits searching for a specific record or group of records meeting certain search
criteria or specifications. Shortcut is ALT+F.
[<] moves to the previous record when multiple records have been retrieved. Shortcut is
ALT+SHIFT+<.
[>] moves to the next record when multiple records have been retrieved. Shortcut is
ALT+SHIFT+>.
[Edit] permits making changes to the current record. The "current" record is the one
displayed on the data form. Shortcut is ALT+E. Do not use this button to add a new
record.
[New] permits adding a new record. Some fields may be filled with default data. Most
fields will be empty and ready for data entry. Shortcut is ALT+N.
[Delete] permits permanently deleting the current record. Deleting a permanent historical
training record is unusual, and requires a higher level of access. The user will be
prompted with an "Are you sure?" dialog box to help prevent accidental deletion.
Shortcut is ALT+D.
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[Close] closes the data form or window. Shortcut is ALT+C on most forms.
[Save] will save changes or new data entered. Shortcut is ALT+S or ALT+ENTER on
most forms. NOTE: On many data forms, the only way to save data is to click the [Save]
button after making changes. This feature prevents accidentally making changes to the
database. User Access Privilege settings can also be used to limit editing capabilities to
specific individuals. This button is only displayed if a record is being edited or a new
record is being added.
[Cancel] will cancel any changes or new data entered. Shortcut is ALT+C on most forms.
This button is only displayed if a record is being edited or a new record is being added.

People Table
Use this form to enter information about people. This includes employees, students,
instructors, supervisors and contacts for the companies table. Generally, these records
should never be deleted if training records are associated with the person. Terminated
individuals can be marked as inactive to keep them from appearing on most reports.
Entering a New Person
Click the [New] button on the People form to begin entering a new record. You will be
prompted to enter a unique user ID before proceeding. Enter the desired data. First name,
last name and ID number are required. All other fields are optional but may be required
by company policy or to produce desired reports. Information is entered and updated in
one table only. For example, if a person has an email address change, it is only modified
in one place.
Once entered and linked to training, a record in the people table becomes part of the
historical training records and should not be deleted unless it is desired to erase all related
records. Use the "Inactive" checkbox to prevent terminated or inactive individuals from
appearing on most reports. Check company policy before deleting terminated or inactive
employees. Some situations require keeping training records for 30 years after a person
terminates.
Schedule/Enroll an Individual for Training
To schedule an individual for training, go to the [Tasks] tab of the current person. Select
the [Schedule/Enroll for Scheduled Training] button. Select one of the three choices for
determining which classes will be displayed in the following list box and then use the
drop-down list box to select the desired class. Select [OK] to complete the enrollment. If
a scheduling conflict occurs, a notification will appear prior to continuing.
Remove/Drop from Scheduled Training
To remove an individual from a class, go to the [Tasks] tab of the current person. Select
the [Remove/Drop from Scheduled Training] button. Use the drop-down list box to
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select the class to remove. Select [OK] to continue. Select a reason from the drop-down
list box and select [OK] to complete the removal.
Linking a Person to a Training Program
Training Programs are used to define required training. A training program is similar to a
track, path or curricula. When a person is linked to a training program, they will be
required to receive the training that is linked to the selected Training Program. To link an
individual to a training program, go to the [Tasks] tab of the current person. Select the
[Link to Training Program] button. Select [New] and use the drop-down list box to select
a Program ID. Enter a target date if desired. Click [Save] to finish the task.
Linking a Person to a Skill
Use this form to link the current person to one or more skill classifications.
TrainingRegister does not relate skills to training; rather skills are an independent
method of classifying people. A person can be linked to a skill after completing training
and/or demonstrating proficiency. To link an individual to a skill, go to the [Tasks] tab of
the current person. Select the [Link to Skill] button and select [New]. Use the dropdown list box to select a skill. You may also choose to enter a skill level, the date
acquired, or the approving supervisor. Select [Save] to complete the task.
Edit Training Records
This form is intended for repairing and querying training records. To edit a training
record, go to the [Tasks] tab of the current person and select the [Edit Training Records]
button. Select the record to be edited from the drop-down list box and select [OK] to
continue. Select [Edit]. By design, not all fields can be edited manually. Make the
necessary changes and select [Save] to complete the task.
Deleting a Person
This function can only be performed when logged in as a Training Administrator. From
the [Tools] menu, select [Training Ad ministrator], then [(2) All Rights Required], then
[Delete All Records for Selected Person]. Follow the onscreen instructions. This
procedure will permanently delete all related records for a selected person. After
completing this task a person’s record in the People table can be deleted by using the
[Delete] button at the bottom of the screen.
Deleting a Duplicate Person
This function can only be performed when logged in as a Training Administrator. From
the [Tools] menu, select [Training Administrator], then [(2) All Rights Required], then
[Prepare to Delete Duplicate People Record]. This function is used to move completed
training records from a source record in the People table to a destination record in the
People table and then delete all remaining related records from the source record so it can
be deleted. This can be useful if a person is entered in the People table twice. Only
“Completed” training records are moved. All other related records for the source are
deleted.
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Companies Table
Use the Companies Table to enter company information about training providers, clients,
licensing authorities, etc. Contacts for each company are in the People table. If you have
a license for the multi-company version of TrainingRegister then you can classify
people by their company and base some reports on that company classification.
Entering a New Record
Click the [New] button on the Companies form to begin entering a new record. Enter the
desired data. Company ID and Company Name are required. All other fields are optional
but may be required by company policy or to produce desired reports.
Once entered and linked to training, a Company record becomes part of the permanent
historical training records and should not be deleted.

ClassCatalog Table
Use this form to enter permanent information about a class, training, ISO document or
learning experience of any kind. The information entered here should remain accurate
for all who have received this training in the past. Generally, these records will never be
deleted or changed once used. A class entered here once can be scheduled many times
without modifying this record. Scheduling information is saved in the ClassSchedule
table.
Adding a New Training Class
A training class is generally only entered one time in the ClassCatalog Table. The
Class can then be scheduled multiple times, each time with different dates, times,
locations, providers and costs. Click the [New] button on the ClassCatalog form. You
will be prompted to enter a unique class ID before proceeding. Enter the desired data.
Class ID, Title and a specified number of Hours are required. All other fields are
optional but may be required by company policy or to produce desired reports. Click
[Save] to save the new class data.
The default Provider and Location can be defined by selecting [Tables], [Configuration
Tables], [Global Options], [General].
Deciding Between Editing or Adding a New Class
Edit or Add a New Class? Small modifications can be made to a class record as long as it
is still an accurate description of the training received by participants in the past. Ask
yourself: “If I change the class information will it be correct for the employees who took
the training 5 years ago?” If the answer is yes, make the change. If the answer is no, add
a new class.
Once entered and used, a training class record becomes part of the permanent historical
training records and should not be deleted or changed (see comment above). Deleting a
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class record will also delete it from the permanent training records of every person
who ever took the class. Changing a class title, description or hours will produce false
information about the training that has previously been administered.
Entering ISO Documents and Revisions
A new ISO document is entered as a new training experience (follow instructions under
the section Adding a New Training Class). The ISO document will be treated as a class
and can be linked to one or more training programs so employees will be required to read
the document and receive the learning.
When a new version is released, open the existing record in the ClassCatalog table, go to
the [Tasks] tab and select [Replicate for New ISO Document]. This Button will create an
exact duplicate of the ClassCatalog record with a new ClassID. You will need to edit the
Revision field to match the new ISO document revision and then click [Save]. All people
who were required to receive the previous ISO document revision will be required to
receive the new ISO document revision. After saving the new ISO document, return to
the previous ISO document and remove its link to Training Programs (also done on the
[Tasks] tab). The old ISO document will then no longer be required but will remain part
of the permanent training records for each person who received it.
Combining Related Records in the ClassCatalog Table
This task may be useful if you accidentally created a duplicate class in the ClassCatalog
table and wish to move all related records to another class and then delete the duplicate.
To do so, select the [Tasks] tab on the ClassCatalog table and click on [Move Related
Records]. You might be prompted to remove some related records or links before the
process can be completed.
Designating Qualified Instructor(s)
Use this form to designate instructors who are qualified to teach this class. This is only
needed if you wish to schedule a qualified instructor with a scheduled class. On the
[Tasks] tab, select [Designate Qualified Instructor(s)]. Select [New] to designate the
instructor. Select a qualified instructor from the drop-down list box. The only names in
the instructor list box will be individuals from the People table who have been classified
as an instructor. This is known as the master list of instructors. They cannot be
scheduled until they have been designated qualified for the specific class. Select [Save]
to complete the task.
Linking a Class to a Training Program
Use this function to link the training/lesson to a Training Program. Doing so will cause
this training/lesson to be required for all people who are linked to the same Training
Program. On the [Tasks] tab of the selected class, select [Link to Training Program].
Select [New] and choose a program from the drop-down list box. Add an interval only if
the training is required on a periodic basis. If training is required only once per student
then leave the interval at zero. Enter a TargetDate only if you want to overrule target
dates set for individuals.
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Linking a Prerequisite to a Class
Use this function to link a prerequisite to the currently selected training/lesson. Doing so
will require prerequisite training prior to performing self-enrollment via the
TrainingRegister Web Module. Training Administrators may elect to override
prerequisites when enrolling via the TrainingRegister Administration Module. On the
[Tasks] tab of the selected class needing prerequisites, select [Link to Prerequisite
Classes]. Select [New] to add a prerequisite, then [Select/Change Prerequisite Class].
Classes from the ClassCatalog table can be selected by Title or ClassID. Click [Save] to
complete the prerequisite addition.
Adding a Class Directly to One or More People
Use this procedure to enter completed training that was NOT scheduled and students
were NOT enrolled. The end result is the same as using the large button on the tasks tab
of the People form except this procedure permits selecting a group of people. The
Current Class will be added directly to the training records of one or more people. A
selected date will be used as the training completion date for all people selected. This
procedure will skip people who are enrolled in any scheduled instance of the Current
Class or already have a completion record for the Current Class. If training records are
mistakenly entered they can be edited or deleted using an edit button on the Tasks tab of
the individual. There is not a batch undo for this procedure. On the [Tasks] tab, select
[Add This Class Directly to One or More People]. Select [Yes] to continue. Choose the
group of individuals to which the class is being added, select [OK] and follow the
onscreen instructions.
Special Security for a ClassCatalog Record
If the [Edit] button is clicked, a Class Title is changed, AND the ClassCatalog record is
referenc ed in other tables, then the user will be prompted with a warning message and
asked if they really want to save the changes. If they choose to continue they must have
the permission named “All Rights” in order to save the record. If the record has not been
referenced in other tables then the user can save changes or corrections without
interference and no harm will be caused.
In addition the ClassCatalog record cannot be deleted if it has been referenced in other
tables. The ClassID can be modified with a new unique value and the ClassID change
will be replicated in all related tables.
Several times someone has clicked the [Edit] button on the ClassCatalog form when they
should have clicked the [New] button to add a new record. They proceed to modify all
the data displayed and save the record. Doing so makes it look like previous students
received completely different training or a scheduled class. Actually the ClassCatalog
record can be related to many other tables so much false information can be ge nerated.
Deleting a Class
This function can only be performed when logged in as a Training Administrator. From
the [Tools] menu, select [Training Administrator], then [(2) All Rights Required], then
[Delete All Records for Selected Class]. This procedure will permanently delete all
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related records for a selected ClassID. After completing this task the ClassCatalog record
can be deleted. Follow the onscreen instructions.

ClassSchedule Table
Training or Lessons in the ClassCatalog table can be entered once and then scheduled
hundreds of times. The ClassSchedule form is used to add a record containing
scheduling information for a specific class in the ClassCatalog Table. Instructors,
students, rooms and resources can be scheduled along with the ClassSchedule record.
When the training is complete, enrollment records can easily be converted to
“Completed” training records with a batch posting process.
Scheduling Process Overview
Classes are scheduled (instructions below); instructors, rooms, resources and students are
scheduled with the scheduled class as desired; an enrollment roster/sign- in sheet is
prepared and given to the instructor; scheduling conflicts are reviewed and dealt with as
necessary; training is administered; people who did not show up for training are
dropped; reasons are permanently recorded; grades/scores are recorded if desired.
All enrollment records are “Posted” with a single click. This batch process converts the
training records from “Enrolled” to “Completed”. It also enters the number of class
hours and updates several other fields with current classifications to facilitate reporting or
review of the training records.
Scheduling a Class
Find and display a Class from the ClassCatalog table. This makes it available for
scheduling. Open the ClassSchedule table/form and click [New] to schedule the current
class displayed on the ClassCatalog form.
Adjust the beginning and ending dates and times to be correct. Enter a number greater
than zero in the StudentMax field. This is required if you want to be able to enroll any
students. Enter a date in the CancelDate field if you want the confirmation letter to
request that students cancel on or before this date.
All other entries are either optional or for general informatio n. Click [Save] to save the
record.
Scheduling an Instructor
Click the [Schedule Instructor] button on the [Tasks] tab on the ClassSchedule form.
Select a qualified instructor from the drop-down list box. Click [OK]. If no instructors
are available in the drop-down list box then follow the on screen instructions to designate
qualified instructors from the [Tasks] tab on the ClassCatalog form.
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Removing an Instructor
Click the [Remove Instructor] button on the [Tasks] tab on the ClassSchedule form.
Select the instructor from the drop-down list box. Click [OK].
Scheduling a Room
Click the [Schedule Room] button on the [Tasks] tab on the ClassSchedule form. Select
a Room from the drop-down list box. Click [OK]. If no Rooms are available in the dropdown list box then none have been entered in the Rooms table. To add a selection, see
instructions in the section for List Box Tables.
Removing a Room
Click the [Remove Room] button on the [Tasks] tab on the ClassSchedule form. Select
the room from the drop-down list box. Click [OK].
Scheduling a Resource
Click the [Schedule Resource] button on the [Tasks] tab on the ClassSchedule form.
Select a Resource from the drop-down list box. Click [OK]. If no Resources are
available in the drop-down list box then none have been entered in the Resource table.
To add a selection, see instructions in the section for List Box Tables.
Removing a Resource
Click the [Remove Resource] button on the [Tasks] tab on the ClassSchedule form.
Select the resource from the drop-down list box. Click [OK].
Enrolling a Student
Find and display the student on the People form. Select [Schedule/Enroll for Scheduled
Training] on the [Tasks] tab of the People form. Select the appropriate scheduled class
from the drop-down list box, the desired scheduled instance of the class, and then click
[OK]. You may check the box for “Show Provider and Room” and then click on
[Refresh Scheduled Instances] to view additional details prior to class selection.
Enrolling a Batch of Students
Find and display the proper ClassSchedule record. Select the [Schedule/Enroll Students]
button on the [Tasks] tab of the ClassSchedule form. Select the group of people you wish
to enroll and follow the on screen instructions.
Note: People cannot be doub le enrolled. The same group can be selected time after time
and only the new people will be enrolled. If the class is full, the extras are placed on a
time stamped waitlist. People can be selected based on classifications used to classify
their personal record such as Division, Department, Group, Job, Rank, Relationship,
Shift, Employment date/range, those on a Waitlist, and those with a specific training
requirement.
Note: If several people are enrolled as a group, such as all the people in a department,
confirmation letters and waitlist letters are not prepared. The TrainingRegister
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Messaging feature can be used to send a user created text message and/or an attachment
to all people on an enrollment roster or a waitlist. See section titled “Messaging”.
Enrolling a Batch of Students Based on Training Requirements
It is advised to run a report prior to performing this task to create a list of people who
need a specific class. From the [Reports] menu select [Required / Needed Training
Related Reports], and [People Who Need a Selected Class]. Enter the selection criteria to
produce the report. To enroll these people, find and display the proper ClassSchedule
record. Select the [Schedule/Enroll Students] button on the [Tasks] tab of the
ClassSchedule form. Select [Schedule People Who Need this Training] and follow the
onscreen instructions.
Note: People will continue to need this training until the class is complete and
enrollment records are posted to history. Only then will they be removed from the list of
people who need the training.
Prerequisite Checking When Enrolling Students
When enrolling a person from the [Tasks] tab of the People form or when enrolling a
single person from the [Tasks] tab of the ClassSchedule form, if prerequisites are not met
then the Training Administrator is presented with a choice to override the prerequisite
checking, skip enrollment and display prerequisites, or to skip enrollment and the report.
When enrolling a group of people from the [Tasks] tab of the ClassSchedule form, the
Training Administrator can elect to skip enrollments when prerequisites have not been
met or to override prerequisite checking and enroll the group.
Dropping a Student
Prior to Posting enrollment records to history, students that did not show up for class
should be dropped out. This can be done from the [Tasks] tab of the People or
ClassSchedule table.
Select the [Remove / Drop from Scheduled Training] button on the [Tasks] tab of the
People form. Select the scheduled class from the drop-down list box and click [OK].

or
Select the [Drop Student] button on the [Tasks] tab of the ClassSchedule form. Select the
enrolled student from the drop-down list box and click [OK].
After posting enrollment records, students cannot be dropped but the record showing they
completed the class can be deleted.
Note: A reason must be entered when dropping a student. To learn how to add selections
to the list box, see the section titled List Box Tables.
Record a Cost for a Scheduled Class
Training expenses or the cost of a class can be entered for a scheduled class. All expense
or adjustment entries must be made before posting enrollment records. Select the
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[Record a Cost or Adjustment] button on the [Tasks] tab of the ClassSchedule form.
Select [New]. Today’s date will automatically appear in the Transaction date field, but
can be adjusted as necessary. Select an account number from the drop-down list box.
(To learn how to add account numbers to the list box, see the section titled List Box
Tables). Enter a description. The expense or cost is entered in the debit field as indicated
on the screen. If, for instance a caterer gives you money back because they fed fewer
students, enter this amount in the credit field to reduce the total class cost. Click [Save]
to save the record.
Grade or Score Students
Grades can be assigned to students of a class before posting enrollment records to history.
Select the [Grade / Score Students] button on the [Tasks] tab of the ClassSchedule form.
Click in the cell to edit. Enter an alphanumeric grade or click a Grade Button. Click
[Close] when finished. The status field has been retained for compatibility with legacy
client data. It has no specific purpose but may fill a special need. Like the grade field it
accepts 3 characters or numbers and is retained with the permanent historical training
records.
Post Enrollment Records to History
Upon completion of a class the following tasks should be performed: 1) drop students
that did not show up; 2) grade students if grading is performed; 3) click the [Post
Enrollment Records to History] button. This will convert enrollment records to
completed training records. See the section “Posting Enrollment Records” for more
details.
Cancel or Kill a Scheduled Class
In the event that a scheduled class is to be cancelled, click the [Cancel / Kill this
Scheduled Class] button to erase all enrollment records and all scheduling records for
instructors, rooms, resources and students. The ClassSchedule record should be deleted
when this process is complete.
Prepare an Enrollment Roster / Sign-in Sheet
Select [Enrollment Roster] from the [Reports] tab on the ClassSchedule form. Take all
the default choices to produce a simple sign- in sheet.

Waitlist Function
If a person is placed on a waitlist, they are linked to a ClassID in the ClassCatalog table
not the specific scheduled class for which they attempted enrollment. The waitlist record
is time stamped. For convenience, the ClassCatalog form displays the number of people
waiting for the class. The count is refreshed each time a ClassCatalog record is selected
and displayed.
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How a Person Gets on a Waitlist
When enrollment is attempted and a scheduled class is full the person is placed on a
waitlist and that record is time stamped. If enrolling with the button on the [Tasks] tab of
the ClassSchedule form, this action occurs without asking. If enrolling individuals with
the button on the [Tasks] tab of the People form, the login user will be notified that the
class is full and asked if they want the person placed on a waitlist.
When enrollment is attempted with the Web Module, the person is automatically added to
the waitlist and the record is time stamped. The login user will receive an instant page
that indicates the person has been placed on a waitlist. The login user could be the
employee/student, a supervisor or an administrator depending on permissions granted.
Note: The Student Max value for a scheduled class can be easily increased to permit
enrollment of more students. If enrolling a group, simply enroll the same group again and
the seats will be filled from those belonging to the group and also on a waitlist. Duplicate
enrollments will not be created. Those already enrolled will be skipped.
Removal from a Waitlist
When the person is successfully enrolled in any scheduled instance of the class for which
they are waiting they will be automatically removed from the waitlist. TrainingRegister
will convert the training record from “Waiting” to “Enrolled” and enter an action date.
Waitlist Report
A Waitlist Report is available from three places for convenience. In all cases the waitlist
report will be based on a ClassID rather than any scheduled instance. The report can be
found on the reports menu and on both the ClassCatalog and ClassSchedule [Reports]
tabs.
Enrollment from Waitlist – TrainingRegister Decides
The waitlist can be used as a source when performing a group enrollment. Simply select
“Enroll People From Waitlist” when performing a group enrollment. People placed on
the waitlist for any scheduled instance of the training will be automatically enrolled until
the class is full.
Enrollment from Waitlist – Training Administrator Decides
A training administrator can pick and choose who to enroll rather than letting
TrainingRegister make that decision. Simply print the waitlist and manually enroll
individuals.
Waitlist Confirmation Letter
The option to prepare a waitlist confirmation letter will be available when enrollment of
an individual fails. If several people are enrolled as a group, such as all the people in a
department, confirmation letters are not prepared. If people are granted permission to
self-enroll with the Web Module, they will be presented with instant confirmation
indicating success of the task. They are not mailed a confirmation letter. In addition,
they can confirm their enrollment by viewing the enrollment roster for the class they
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selected and their own personal training schedule. If people are not granted permission to
self-enroll with the Web Module then an enrollment request is emailed to either the
person's immediate supervisor or the training administrator, or both. Enrollment is then
performed manually using the Administration Module and a confirmation letter can be
prepared. The TrainingRegister Messaging feature can be used to send a user created
text message (confirmation letter) and/or an attachment to all people on an enrollment
roster or a waitlist.

Tracking Training Costs
Each training record linking a person to a learning experience can contain a cost for
training that person. Training records can also be classified by division, department,
group, job and others. If costs and classifications are recorded with the training records
then reports can be generated from the training records showing the total cost of training
an individual for a date range, the total cost of training all the people in a department for
a date range, etc. Costs can be recorded with the permanent training records using one of
two methods.
The first method involves entering a value for training a single person on the
ClassCatalog form and then directly linking people to that class. The enrollment process
is skipped. The value entered on the ClassCatalog form is saved with the training record
for each person who is directly linked to the class. The cost value on the ClassCatalog
form affects only training records that are created after the cost has been entered or
changed.
The second method of recording training costs with each training record involves
scheduling a class. Costs are linked to a scheduled class using a button on the tasks tab
of the ClassSchedule form. Each cost is entered as a transaction with a date, an account
number, description and an amount. When the class is finished and the enrollment
records are posted or converted to completed training records, the total of all transactions
is divided equally among each student and recorded in their permanent training record.

Posting Enrollment Records
Enrollment records are simply records in the TrainingRecords table that are classified as
“Enrolled” and lack Hours, CEU, etc. because the training has not been completed. The
“Posting” process converts the records to “Completed” and credits the students with the
appropriate training history. This topic will describe what happens in this process.
Grading
If you wish to Grade students or enter a value in the Status field, be sure to complete this
task before you perform the Posting as described in this section. This can be done later
but it is much easier to do before Posting.
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Grading is performed by selecting the [Grade / Score Students] button on the
ClassSchedule [Tasks] tab.
Posting
Posting is performed by selecting the [Post Enrollment Records to History] button on the
ClassSchedule [Tasks] tab. The following describes what happens behind the scenes.
Recording Training Costs:
The button [Record a Cost or Adjustment] is used to add costs in the form of a
transaction. You will be prompted to select an account number, enter a description and
enter a debit or credit amount. Multiple transactions can be recorded and a report
detailing all transactions can be prepared. This data can also be exported for custom
reporting.
When enrollment records are posted or converted to “Completed” training records all
costs/transactions are totaled and divided equally among each student. This cost per
student is saved with the training record along with the student’s current division,
department, group and job classification.
Modification to the Training Record:
The ClassScheduleID field is erased removing any link to the ClassSchedule record.
The Completed field is filled in with the ClassEnd date on the ClassSchedule form.
The Phase field is converted from “Enrolled” to “Completed”.
The Hours field is filled in with the Hours as defined on the ClassCatalog record.
The CEU field is filled in with the CEU as defined on the ClassCatalog record.
The Cost field is filled in with the Cost Per Student value described above.
In case the classifications for the Student or Employee have changed since they were
enrolled, the following fields are updated:
The DivisionID field is updated with the DivisionID currently used to classify the person.
The DeptID field is updated with the DeptID currently used to classify the person.
The GroupID field is updated with the GroupID currently used to classify the person.
The JobID field is updated with the JobID currently used to classify the person.
The RankID field is updated with the RankID currently used to classify the person.
The AccountCode field is updated with the AccountCode currently used to classify the
person.
The scheduling record in the PeopleSchedule table is deleted.
If the RequirementAutoUpdate switch is checked in the Global Options tables then the
Program Requirements for each student is also updated to reflect the completed training.
These activities can be confirmed by viewing each students Training Records, Training
Schedule and Training Program Requirements report before and after posting.
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Because the records are no longer linked to the ClassSchedule record, the number of
people enrolled will drop to zero.
The Posted date on the ClassSchedule form will be filled in with the current system date
and the Posted2History checkbox will be checked for reference. A Posted ClassSchedule
record is frozen from use and cannot be edited.
The ClassSchedule record may be deleted or retained for future reference. It cannot be
used for scheduling.

Training Programs
Tracking Required Training Based on Program Requirements
Training Programs are used to track the progress of specific required training for
individuals or groups of individuals. A training program is sometimes called a path, track
or curricula. Required training can be specified for virtually any reason. Often training
is required because a person is a new employee, works in a specific location, or performs
a specific task. The possibilities are unlimited. A training program can contain one or
more classes, and a person can be linked to one or more training programs.
Reports can be generated to display what training needs to be administered, who needs
each class, and how each individual is progressing on their required training. Some of
these reports can be created based on a specific Rank, Job, Group, Department, or
Division. Groups, Departments, and Divisions can be linked to specific Supervisors. If a
multi-company license is purchased, required training can be tracked by the Company
classification of individuals.
Creating a Training Program Name
The first step is to create or invent a training program name. The program name should
have meaning to those who will view the reports. If training is required for a specific
task, then name the program with that task. If training is required because a person is in a
specific department, then name the program with that department name. If training is
required for all new employees, then name the program accordingly, i.e. “New Employee
Orientation”.
Next, add the new Program name to the list of programs. The Programs table is accessed
from the [Tables] menu. Select [List Box Tables], [Required Training Related List
Boxes], then [Programs]. Confirm your new program name does not already exist, and
then click [New] to add a new record.
Linking a Class to a Program
Locate the specific class in the ClassCatalog table. Select the [Tasks] tab and then click
[Link to Training Program]. Confirm the class is not already linked to the program, and
then click [New] to add a new record.
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Select the Program from the list box. Add a monthly interval if the training is to be
received periodically by each person. Enter a TargetDate if you wish all people required
to receive the training receive it by the same TargetDate. This target date will overrule
the target dates entered for each person.
Linking a Person to a Program
Locate the specific person in the People table. Select the [Tasks] tab and then click [Link
to Training Program]. Confirm the person is not already linked to the program, and click
[New] to add a new record.
Select the Program from the list box. Add a TargetDate if desired. A target date entered
at the class level will overrule a target date entered here. If no target date is entered, the
training will be due now and will be included on reports displaying needed training
regardless of the future date entered in the report selection process.
Linking a Program to a Group
This function will add a training program to a selected group of people. From the [Tools]
menu select [ProgramRequirements Tasks], [Add Training Program to Group of People].
All classes that are linked to the specified training program will be required for each
individual belonging to the selected group.
Removing a Program from a Group
This function will add a training program to a selected group of people. From the [Tools]
menu select [ProgramRequirements Tasks], [Remove Training Program from Group of
People]. All classes that are linked to the specified training program will no longer be
required for each individual belonging to the selected group.
Behind the Scenes
A hidden table named “ProgramRequirements” is used to produce reports displaying
what training needs to be administered, who needs each class, and how each individual is
progressing on their own training requirements.
The automatic updating of records in the “ProgramRequirements” table is triggered by
any change that would affect the requirements of an individual. These include any
change made in the linking of a class to a program, a person to a program, or completion
of a required class.
Most of the fields are self-explanatory. It may be helpful to understand how the
TargetDate, CompletedDate, Interval and NextDue fields are calculated and how they are
used.
As an example, when a report is generated to display all people who need a specific class,
the ProgramRequirements table is queried for matching records which have a NextDue
date that is either not empty or contains an earlier date than a user specified future date.
The NextDue date will be empty if the training has been completed and is not required
again in the future.
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TargetDate
The target date is first selected from the record that links the class to the program. If a
target date is not found then it will be selected from the record that links the person to the
program. If no target date is found then that field will be left blank.
CompletionDate
This is the date the class was last completed. The TrainingRecords table is searched to
determine if and when the person last completed the class.
Interval
The interval is selected from the record that links the class to the program. The interval
will be zero if the training is required once in a lifetime for each person. Otherwise it
will have a monthly periodic interval greater than zero.
Note: If you use a periodic interval when linking a ClassCatalog record to a training
program, make sure no target dates are entered for the class or the person who needs the
class. If you use a target date don't use a periodic interval for any training affected by the
target date. TrainingRegister is not programmed to make a decision when both a target
date and a periodic interval are involved
NextDue
The presence of a date in this field indicates the training is needed and specifies when it
is due.
Periodic Training : If the class has been completed then the NextDue date is calculated
by adding the monthly interval to the last completion date. If the class has never been
completed then the NextDue date is the same date the record was created or last updated.
Periodic training will always be needed. Report selection permits selecting training that
is needed prior to a user specified future date.
Non-Periodic Training : If the class has been completed then the NextDue date is left
blank, indicating the class is not needed. If the class has not been completed and a target
date is found, then the target date will be used for the NextDue date. If the class has not
been completed and a target date is not found, then the NextDue date will be the same
date the record was created or last updated. Non-periodic training will either be needed
or not needed, indicated by the presence or absence of a NextDue date.

Messaging
The Messaging Menu is used for sending messages and attachments to most any group of
people in the People table including the following:
•

One or more individuals based on data or classifications in their People table
record
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•
•
•
•

Students on an Enrollment Roster
People on a Waitlist
People who Need a Class/Training
People who are Linked to a Training Program

Note: The [Messaging] menu is visible only if EnableMAPI_Messaging is checked on
the General Options form in the Configuration tables.
Testing the Messaging Feature
To test the Messaging feature, a recipient is needed to receive the test message. Because
the Sample database is filled with fake e- mail addresses, add yourself to the People table
and enter your email address at the bottom of the [Contact] tab.
From the [Windows] menu, open the People table. Click the [New] button located in the
bottom left corner of the window. Enter in a unique people ID and click [OK]. For
demonstration purposes, a last name, date of birth, or SSN will work. Fill out the
required information on the [General] tab. Switch to the [Contact] tab and enter in an email address. At this time no other information is necessary. Click on the [Save] button
at the bottom of the window.
Note: Actual mail will be sent to this e- mail address. Please use a working e- mail that is
accessible.
Sending a Message to Test Recipient
The Test Recipient is used so that if there is an error or the e- mail is wrong, the user can
see the actual e- mail in his/her inbox to inspect it before sending it out to a large group of
people if it happens to be incorrect.
Click on the [Messaging] menu at the top of TrainingRegister® and select [Create / Send
Message]. Enter a subject in the Subject Field. You may choose to select a salutation or
the default selected is No Salutation. Type or paste the message into the Message Field.
To attach a file, use the [Select Attachment] button.
Note: The message can be typed, retrieved from a text file or Pasted from the Windows
Clipboard using the buttons at the bottom of the Message Body field.
Click on the [Select Recipients] tab. Click on the [Select Test Recipient] button in the
top right corner of the form. Click [OK] to search by last name. Enter in YOUR last
name, click [GO], and select yourself from the list box. The form is now filled with your
name, e- mail address, and ID.
Click on the [Send / Test Message] tab. Click on the [Send Test Message] button. A
report will display the list of recipients, whether or not the message was skipped, and the
subject, message and file name for any attached file.

24

Without closing TrainingRegister®, send and receive your e- mail to make sure
everything looks acceptable. If all is well, return to TrainingRegister®.
Note: If your system is configured with a MAPI compliant email program the message
will be placed in your Outbox. If this does not work correctly contact your IT support
staff and/or TrainingRegister support staff. Installation details can be found in the
[Technical Notes] located on the [Help] menu.
Selecting Multiple Recipients
The [Select Recipients] tab contains several buttons for selecting recipients. The
selection process is similar to selecting records for the corresponding reports.
Click [Selected Recipients Report] to see the recipients without actually sending the
message.
Select the [Send Message] button to send the message and produce the report. Recipients
are skipped if their email address is missing or appears defective. A recipient marked as
“Sent” only means the message was placed in the Outbox. It does not verify delivery.

List Box Tables
All list boxes found throughout the software are configured using a table. The only
exception is the Languages table. Its values contain only "English" and "Spanish", and
cannot be changed. Each table can be found on the [Tables] menu, [List Box Tables],
select the appropriate category and then the specific table for the list box you are
configuring. To add a choice to a list box, select [New]. To run a report of all the
choices, select the [List] button under the entry box or select [List Boxes...] from the
[Reports] menu. You may also edit or delete a choice from this table.

Date/Time Entry and Formatting
Overview
TrainingRegister® uses two different kinds of date entries because some date fields must
be erasable and optional, while others require an entry. Date/time entry and display
formats are handled both by Windows and by optional settings within TrainingRegister®.
Standard Date Fields (erasable) look like any other text box and have a small button to let
the user access a Windows Date/Time Picker and its pop- up calendar. An example is the
termination date on the People form. The date entry is optional and can be erased if the
person is rehired. The entry in the date field can be deleted or edited with the keyboard.
If a date is selected using the pop-up calendar, it will be inserted in the date field. The
display format for these fields is controlled by the Windows Short Date format, which
can be configured in the Windows Control Panel. The entry format in this field is
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controlled by settings within TrainingRegister®. These settings are found from the
[Tables] menu, [Configuration Tables], [Global Options], [Date/Time Formatting]. If the
Standard Date Field does not display with the same format used for entry or it does not
recognize the entry as a valid date, then configuration of Windows or TrainingRegister
or both will be needed. If Windows cannot interpret the entry as a valid date, then the
date will not be saved and the date field will appear blank.
Required Date Fields (non-erasable) look more like the date fields used in the Microsoft
Outlook calendar. The Windows Date/Time Picker is displayed on the form. An
example is the ClassBegin date on the ClassSchedule form. The date can be edited with
the keyboard but not deleted. The pop-up calendar can also be used to select a date. The
display and entry formats for these fields are controlled by settings within
TrainingRegister®. These settings are found from the [Tables] menu, [Configuration
Tables], [Global Options], [Date/Time Formatting].
If a needed format is not listed, please contact the vendor with a request.

Supervisor Record Filtering
The [Find] button on the People table in the Administration Module and the [Find/Select
a New Person] button in the Web Module are protected to prevent unauthorized retrieval
of records. In order for these buttons to work one of the following conditions must be
met:
1) The login user has been granted the security right “(4) View All People”.
2) The login user is classified as a supervisor of a Division, Department or
Group.
Condition 1 overrules condition 2. If a login user is a supervisor of a Division,
Department or Group and they have the right “(4) View All People” then they can use the
[Find] button to search for and view the records of any person in the table.
If a person is a supervisor and they do not have the right “(4) View All People” then they
will only be able to search for and view the records of the people under their supervision.
Web Module
The above works exactly the same on the Web Module except that it also controls the
login user’s ability to get beyond the ability to only see their own records.
One of the above conditions is required to either search for an individual or access any of
the Supervisor or Administration level menus.
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Supervisor Filtering
The filter is set for the highest level found. If a person is a supervisor of both a Division
and a Department they will have rights to retrieve and view all employees under their
division supervisor control. The department level will be ignored.
The levels are Division, Department and Group with the Division being the highest level
and the Group being the lowest level.

Reporting
Locating Reports
[Reports] Menu. All reports can be found on the [Reports] menu located on the top menu
bar in the line [File], [Tables], [Reports], [Tools], [Messaging], [Window] and [Help].
Reports are grouped according to base of origin or topic. Required and Needed Training
reports are generally grouped together even though they might be based on a person,
class or training program. A brief overview of reports available from the [Reports] menu
can be found in the appendix.
[Reports] Tab. Some forms contain a [Reports] tab. If so, a few common reports will be
replicated on this tab. An example is the [Reports] tab on the ClassCatalog form.
Generally, reports found on the [Reports] tab of a form will be specific to the record
displayed on that form which is referenced as the Current Person or Current Class.
A few reports are replicated on some of the forms. An example would be the form for
entering new Training Programs. A button permits quickly viewing all existing
programs.
A few reports are available only to the TrainingRegister system administrator for
diagnostic, security and testing purposes.
Closing Reports
All reports are displayed in the user’s default browser. Simply close the browser to close
the report.
Safety of Data with Reports
No report in TrainingRegister will modify the master database in any way. Making
choices on reports cannot damage data.
Customizing TrainingRegister Reports
Most report selections will prompt the user to make some choices. If choices are made
more choices might be requested. Pressing the ENTER key or clicking [OK] to take the
default selections will produce a predefined report with all available records. For
instance, selecting a specific Job will limit the records to people or training records
classified with that Job.
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A Supervisor can extract many reports. To accomplish this, select the specific Division,
Department or Group for which the supervisor is in charge.
Printing or Emailing Reports
All reports produced by TrainingRegister are written to C:\TrReports and are displayed
in the user’s default browser.
To Email a displayed report with Internet Explorer, select [Tools], [Mail and News],
[Send Page] or select the mail icon on the IE tool bar. This will launch the user’s default
email program.
To print a displayed report, simply print it as you would any web page.
Some reports in TrainingRegister are emailed directly by communicating with the
user’s MAPI compliant default email program. This feature can be turned on or off to
accommodate users with or without compatible equipment and software.
Copying Data to Excel
Most reports contain data that can be copied to an empty Excel spreadsheet. Display the
grid on the report and then use the mouse to copy all or part of the data contained in the
cells to the Windows clipboard. Open a blank Excel spreadsheet and paste.
Using an External Report Writer
TrainingRegister permits making a complete copy of the database in Access format. It
is also possible to export a single table to an Access table or a comma-delimited file. The
resulting Access file and/or the comma-delimited file will not be password protected and
can be used with external report writers or other systems. Note: The exporting feature is
not available on the demo version and may be turned off by IT staff for security reasons.
If TrainingRegister is licensed for use with a database server such as SQL Server or
Oracle, then your database administrator may grant you “Read Only” privileges to the
database for reporting purposes. The TrainingRegister standard software license states
that “Read Only” privileges may be granted to users or other systems.
Description of Report Categories
This section describes the types of reports found in each report category. Because of the
endless possibilities, we will not make an attempt to document or display an example of
every report, however more detail can be found in the appendix. It makes better sense to
simply experiment with all the choices for each report. Data cannot be damaged or
modified by running reports.
People Related Reports – Reports centered on an individual or group of individuals. For
example, Training Records or a Training Schedule for an individual, or a list of people
who meet report selection criteria.
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ClassCatalog Related Reports – This section contains many different reports. For
example, a list of classes meeting report selection criteria, completed training records, or
scheduled times and dates a class is offered.
ClassSchedule Related Reports – Reports related to scheduled classes. For example, the
class roster, sign- in sheet, waiting list, cost summary, or a list of all scheduled classes for
a specific date range.
Required/Needed Training Related Reports – Reports will only show data if people and
classes are linked to training programs. Training programs are used to identify classes
that are required for individuals for various reasons. For example, all required classes,
people who need a specific class, classes that are part of a training program, or people
who are linked to a training program.
Skill Tracking Reports – Reports related to skills. For example, a list of people who have
a specific skill or a list of skills for a specific person.
List Box Reports – Reports listing choices for all drop-down list boxes on each of the
different forms. For example, departments on the People table, providers on the
ClassCatalog table, and resources on the ClassSchedule table.
Training Records - Other – Reports displaying the selected information for training
records.
Security Reports – Reports displaying information about security settings.

Selecting and Tagging Records
Tagging - Overview/Purpose
Tagging can be used to enhance reporting capabilities and perform a few batch processes
like enrolling a selected group of people or putting a selected group of individuals in a
training program. Generally, tagging is not needed because TrainingRegister provides
many other ways of selecting a group of people.
The tagging process permits a user to select only certain records for inclusion on reports
or for merging with Microsoft Word. A little knowledge gained in this section can open
the door for advanced reporting capabilities using the reports that are included with
TrainingRegister or by marking records for reporting with an external custom report
writer.
Tagging will be necessary if records cannot be selected with one of the many options
provided. For example, if all people in a department are to be enrolled, tagging is not
needed because this option is provided. If all people in a particular city are to be enrolled
in a class then it would be necessary to tag the people who meet the desired search
criteria and then enroll the tagged people.
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Tagging for Single Records
A single record can be Tagged by simply checking the "Tag" checkbox on the People
form or the ClassCatalog form. The [Edit] button must be selected before field values can
be changed.
Tagging for Multiple Records
Multiple records meeting a user's search specifications can be tagged simultaneously by
using buttons found on the [Tasks] tab on the People form.
Other Options
[Tag All Records] – This button will tag all the records in the database.
[UnTag All Records] – This button will untag all the records in the database. Be sure to
untag all records before beginning a new operation. Records stay tagged until the y are
specifically untagged.
[Tag Retrieved Records] – This button will tag all records that have been retrieved using
the [Find] button.
[UnTag Retrieved Records] – This button will untag all records that have been retrieved
using the [Find] button.
[Count Tagged Records] – This button will count how many records are tagged in the
database and provide the user with a current number.
[Invert Tagged Records] – This button will untag all records that have been tagged, and
tag all records that were not tagged. This can be especially helpful when needing to tag
everyone except for a small set of individuals, which can be achieved by tagging the
small set and then inverting the tagged records.

Data Export
All data from a selected table can be exported to a comma-delimited file or to an Access
database. All data in all tables can be exported to an Access database. The resulting files
are not password protected and can be used for custom reporting or to feed another
system with data from TrainingRegister. Passwords saved in the TrainingRegister
database are encrypted.
A comma-delimited file can usually be opened with Microsoft Excel by simply doubleclicking the file. Access files can be opened with Microsoft Access, Microsoft Word,
SQL Server and custom report writers like Crystal Reports.
Export a Table to a Comma-Delimited File
1. Select [Tools], [Export], [Table to Comma-Delimited File].
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2. Select the table to export from the list box.
3. A message displays the name and location of the comma-delimited file.
Export a Table to an Access File
1. Select [Tools], [Export], [Table to Access File].
2. Select the table to export from the list box.
3. Select or Create the Destination Database.
4. A message displays indicating the success of the copy and the name and location
of the Access File.
Export All Tables to an Access File
1. Select [Tools], [Export], [All Tables to Access File]
2. Select or Create the Destination Database.
3. A message displays indicating the success of the copy and the name and location
of the Access File.
Note: TrainingRegister may contain tables that contain no data. The reason could be
that the tables have not been used or that the tables are intended for future use.
Empty tables might be skipped as indicated in the on screen messages. This does not
mean anything is wrong.
Microsoft provides us with a function to quickly replicate a Jet database to an Access
database. If your TrainingRegister license is for use with a Jet database, the Export All
Tables to an Access File will be very quick. Otherwise, each table and each record are
copied one at a time and the process may take a few minutes.
Useful Reports Used for Data Export
Three reports specifically designed for data export can be found under [Reports],
[Training Records – Other]. When using these reports, all data within the grid, including
the column headings, can be copied to the Windows Clipboard and pasted into an empty
Excel spreadsheet.

SQL Searching
Using SQL to Select Records
All four tables can be searched using a technique called Standard Query Language (SQL)
or Sequel. SQL searching offers extended user flexibility. After the records are
selected, they may be tagged and used for a report, merge, or other special feature.
SQL is an industry-standard database language that has origins from the early 1970's and
is used on many large computer systems, SQL Server and Oracle. The TrainingRegister
database supports SQL searching.
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It is not necessary to learn all about SQL. Generally, users only input something as
simple as "field name = search value". For exact syntax, see the next few pages for
examples of searching Text, Memo, Date, Numeric, and Boolean fields.
Those who want to perform more sophisticated searches can use any valid SQL
comparison operator. Examples of comparison operators are "=", "Like", ">", and "<".
Key words "AND" and "OR" can also be used.
Users CANNOT DAMAGE OR CHANGE the database with SQL searching.
To enter search criteria, click the [Find] button on the desired table and then select the
[SQL Query] option. Enter the field name, comparison operator and search value in the
"Where" text box. No other box needs to be edited. TrainingRegister will construct the
rest of the SQL statement automatically.
The constructed SQL statement is often displayed for your viewing pleasure and
troubleshooting. It is not necessary to understand or read this statement.
Entering SQL Search Criteria
Click the [Find] button on the desired table. Select the [SQL Query] option in the Search
Method box and select [OK]. Enter a search specification in the box or select a
previously saved query from the drop-down list box.
After searching, the records matching the search specification will be displayed.
SQL Searching Text and Memo Fields
Rules:
Syntax: WHERE FieldName = 'CHARACTERS TO SEARCH FOR'
Characters to search for are not case sensitive and must be enclosed in single quote
marks.
Sample search strings:
WHERE Last = 'SMITH'
Finds all records where the last name is "Smith".
WHERE Last LIKE 'SMITH%'
Finds all records where the last name begins with "Smith". Notice the percentage symbol
at the end of the search string.
WHERE DevelopmentPlan LIKE '%ENGINEER%'
Finds all records where the DevelopmentPlan memo field contains the characters
"engineer" anywhere in the field. Notice the percentage symbol at the beginning and end
of the search string.
WHERE DevelopmentPlan LIKE '%ENGINEER%' OR DevelopmentPlan LIKE
'%DEVELOPER%'
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Finds all records where the DevelopmentPlan memo field contains either the characters
"engineer" or the characters "developer". Notice the logical operator "OR" and the
percentage symbol.
WHERE DevelopmentPlan LIKE '%ENGINEER%' AND DevelopmentPlan LIKE
'%DEVELOPER%'
Finds all records where the DevelopmentPlan memo field contains both the characters
"engineer" and the characters "developer". Notice the logical operator "AND" and the
percentage symbol.
WHERE Classify1 = 'EMPLOYEE'
Finds all records where the Classify1 field has the value of "employee".
WHERE Classify1 <> 'TERMINATED'
Finds all records where the Classify1 field is not equal to "terminated".
WHERE HomePhone = '316/555-1212'
Finds all records where the home phone field has a specific phone number.
SQL Searching Date Fields
Rules:
Syntax: WHERE FieldName = DateValue('MM/DD/YYYY')
Date to search for must be enclosed in single quote marks and the DateValue function
must be used to enter a specific date value.
Sample search strings:
WHERE HireDate = DateValue('8/15/1995')
Finds all records where the employment date field equals 8/15/1995.
WHERE HireDate > DateValue('6/1/1990')
Finds all records where the employment date is newer than 6/1/1990.
WHERE HireDate BETWEEN DateValue('1/1/1989') AND DateValue('12/31/1990')
Finds all records where the employment date falls in 1989 or 1990.
WHERE TermDate BETWEEN DateValue('2/1/1998') AND DateValue('2/28/1998')
Finds all records where the Termination date falls in February 1998.
WHERE Month(HireDate) = 6
Finds all persons hired in the 6th month or June.
WHERE Year(HireDate) = 1996
Finds all persons hired in 1996.
WHERE Month(DOB) = 3 AND Day(DOB) = 15
Finds all persons whose birthday is March 15.
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SQL Searching Numerical Fields
Rules:
Syntax: WHERE FieldName = NUMBER
Numbers to search for must not be enclosed in single quote marks.
Sample search strings:
WHERE Hours >= 20
Finds all records where the class hours are equal or greater than 20.
SQL Searching Logical (yes/no) Fields (Boolean type fields)
Rules:
Syntax: WHERE FieldName
Logical Operators: NOT
Sample search strings (for Jet database):
WHERE Instructor
Finds all records where the Instructor field is True or Checked.
WHERE NOT Tag
Finds all records where the Tag field is False or Un-Checked.
Sample search strings (for SQL Server database):
WHERE Instructor = 1
Finds all records where the Instructor field is True or Checked.
WHERE Tag = 0
Finds all records where the Tag field is False or Un-Checked.

Global Option Settings
General
DefaultProviderID – This value is used when creating a new ClassCatalog record.
DefaultCity – Used when creating a new Companies or People record.
DefaultStateProvince – Used when creating a new Companies or People record.
DefaultCountry – Used when creating a new Companies or People record.
ForceUpperCase – If checked, lower case letters cannot be used. Initial setting =
unchecked.
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EnableMAPI_Messaging – If checked, TrainingRegister® will send email using the
user’s MAPI compliant email program such as Outlook or Outlook Express. Remove
check to disable this feature. Initial setting = checked.
Date/Time Formatting
Standard Date – Defines or controls the entry only of dates typed in a standard date
fields. Dates entered must be recognized by the local settings for the operating system.
Initial setting = “MM/dd/yyyy” (03/28/2002) (USA).
Date Picker – Controls entry and display of dates when the date/time picker is used to
enter dates. Initial setting = "dddd MM'/'dd'/'yyyy" (Thursday 03/28/2002) (USA).
Time Picker – Controls entry and display of times when the date/time picker is used to
enter times. Initial setting = "hh':'mm tt" (02:00 PM) (USA).
English Report Short Date – Controls display of dates on English reports when a short
date is used. Initial setting = "MM/dd/yyyy" (03/28/2002) (USA).
English Report Long Date – Controls display of dates on English reports when a long
date is used. Initial setting = "mmmm d, yyyy" (March 28, 2002) (USA).
English Report Time – Controls display of times on English reports when time data is
used. Initial setting = "hh:mm AMPM" (02:00 PM) (USA).
Spanish Report Short Date – Controls display of dates on Spanish reports when a short
date is used. Initial setting = "dd/MM/yyyy" (28/03/2002).
Spanish Report Long Date – Controls display of dates on Spanish reports when a long
date is used. Initial setting = "dddd, dd ""de"" MMMM ""de"" yyyy" (Friday, 28 de
March de 2003). Spelling may be different depending on OS settings.
Spanish Report Time – Controls display of times on Spanish reports when time data is
used. Initial setting = "HHmm ""hrs.""" (1400 hrs.).
Confirmation Letter
DefaultConfirmationHeader – Defines the header used on enrollment confirmation letters
and is used to fill the related field when a new ClassCatalog record is created. When a
confirmation letter is created this default value is used if the header has not been defined
in the ClassCatalog record. Initial setting = "This letter is to confirm your enrollment in
the following training:"
DefaultConfirmationFooter – Defines the footer used on enrollment confirmation letters
and is used to fill the related field when a new ClassCatalog record is created. When a
confirmation letter is created this default value is used if the footer has not been defined
in the ClassCatalog record. Initial setting = "If you wish to cancel or postpone, please do
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so on or before the last free cancellation date listed above. The dress code for this training
is business casual. Sincerely, Training Administration Team"
DefaultConfirmationHeader_Sp – Same use as the DefaultConfirmationHeader but will
be used when the recipients preferred language is set to Spanish. Initial setting = "Has
sido convocado/a al siguente entrenamiento:"
DefaultConfirmationFooter_Sp – Same use as the DefaultConfirmationFooter but will be
used when the recipients preferred language is set to Spanish. Initial setting = "Si desea
cancelar o posponer, por favor hágalo a más tarder en la fecha de cancelación sin cargo
indicada arriba. El atuendo sugerido para la sesión es elegante sport.”
ConfirmationIncludeTuition – Defines whether or not to include the Tuition on
confirmation letters.
ConfirmationIncludeCancelDate – Defines whether or not to include the CancelDate on
confirmation letters. Students can be requested to cancel on or before this date.
Waitlist Notification Letter
DefaultWaitListNotifyHeader – Defines the header used on a waitlist notification letter.
Initial setting = "Thank you for your computer training registration. Unfortunately, due
to enrollment limitations you have been placed on a WAIT LIST for the following."
DefaultWaitListNotifyFooter - Defines the footer used on a waitlist notification letter.
Initial setting = "Should space become available in this class, you will be enrolled and
sent a confirmation letter. If you have any questions, contact your training administrator.
Sincerely, Training Administration Team”
DefaultWaitListNotifyHeader_Sp – Same use as the DefaultWaitListNotifyHeader but
will be used when the recipients preferred language is set to Spanish.
DefaultWaitListNotifyFooter_Sp - Same use as the DefaultWaitListNotifyFooter but will
be used when the recipients preferred language is set to Spanish.
Individual Schedule
DefaultIndividualScheduleHeader - Defines the header used on a schedule for an
individual. Initial setting = "You have been scheduled for the following training:”
DefaultIndividualScheduleFooter - Defines the footer used on a schedule for an
individual. Initial setting = "Please note any scheduling conflicts. Contact your training
administrator, supervisor, or the instructor for the class if you have any questions or need
to cancel."
DefaultIndividualScheduleHeader_Sp – Same use as the
DefaultIndividualScheduleHeader but will be used when the recipients preferred
language is set to Spanish.
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DefaultIndividualScheduleFooter_Sp - Same use as the DefaultIndividualScheduleFooter
but will be used when the recipients preferred language is set to Spanish.
Required Fields
ReqClassGrouping – If checked, a ClassCatalog record cannot be saved unless a valid
ClassGrouping is selected from the list box.
ReqSubjectCategory – If checked, a ClassCatalog record cannot be saved unless a valid
SubjectCategory is selected from the list box.
ReqRank – If checked, a People record cannot be saved unless a valid Rank is selected
from the list box.
ReqJob – If checked, a People record cannot be saved unless a valid Job is selected from
the list box.
ReqGroup – If checked, a People record cannot be saved unless a valid Group is selected
from the list box.
ReqDept – If checked, a People record cannot be saved unless a valid Dept is selected
from the list box.
ReqDivision – If checked, a People record cannot be saved unless a valid Division is
selected from the list box.
ReqClassify1 – If checked, a People record cannot be saved unless a valid Classify1 value
is selected from the list box.
ReqClassify2 – If selected, a People record cannot be saved unless a valid Classify2
record is selected from the list box.
ReqClassify3 – If selected, a People record cannot be saved unless a valid Classify3
record is selected from the list box.
Field Screen Names
NameEmplNum – Defines the screen name of the field initially labeled EmplNum on the
People form.
NameAccountCode – Defines the screen name of the field initially labeled AccountCode
on the People form.
NameClassify1 – Defines the screen name of the field initially labeled Classify1 on the
People form.
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NameClassify2 – Defines the screen name of the field initially labeled Classify2 on the
People form.
NameClassify3 – Defines the screen name of the field initially labeled Classify3 on the
People form. Note: Renaming field screen names can cause confusion if SQL queries
are used to find and retrieve records. The actual field name must be used in the SQL
query.
Program Requirements
RequirementsAutoUpdate – If checked the ProgramRequirements table is automatically
updated each time a change is made to the linking of a program to a class, the linking of a
program to a person or the recording of completed training records.
It may be beneficial to turn this off when initially setting up program requirements for
people and classes. A manual update can be performed with a selection on the [Tools]
menu.
Web Module
DefaultAdminID – Receives enrollment requests if no training administrator has been
defined on the ClassCatalog record. EnableSelfEnrollment must be unchecked for
requests to be mailed.
Requests2Supervisor – If checked a student’s first level supervisor will be sent a copy of
the enrollment request made via the Web Module. EnableSelfEnrollment must be
unchecked for requests to be mailed.
Requests2Administrator – If checked the training administrator as defined on the
ClassCatalog record will receive a copy of the enrollment requests made via the Web
Module. EnableSelfEnrollment must be unchecked for requests to be mailed.
Import Utility Rules
Use this form to select fields to be included and fields to be updated with the Built- in
Import Utility. A separate document explains rules applied to each field during the
import process. This task should be a joint effort between a training administrator and a
technical person. File preparation and configuration of the import process is not designed
for a non-technical person. A Custom Import Utility can be purchased if needed.
Detailed instructions for configuring and using the Built- in Import Utility can be found
by selecting [Tools], [Import Utility], [Periodic Employee Data - People Table].
Software Registration Information
Use this form to make changes to your registration information. The CompanyName,
CorpID, and RegNum can all be copied and pasted into this form to minimize possible
typographical errors.
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TrainingRegister® Change Tracking Option
When Change Tracking is enabled any change to the TrainingRegister master database
is logged with a few exceptions noted below. The date of the change, user id, table name,
field name, old value, new value and an action indicating if the record was edited, deleted
or added as a new record are all saved in the log.
Changes to all training data and all employee data and all permanent training records are
tracked.
Data Security for Companies Regulated by FDA CFR Title 21, Part 11
No one can change data without a proper login ID and Password or a proper network
login. Passwords in TrainingRegister are encrypted so data exports will not display
usable passwords. No two users can have the same ID and Password combination.
The database is protected with a strong password. If TrainingRegister is used with a Jet
database, no one will know the database password except the developer. If a SQL Server
database is used then a strong password unique to the organization will be provided to the
SQL Server Database Administrator.
If the Change Tracking Option is purchased, a letter identifying and authorizing the
Database Administrator to receive the password will be required. By license, users of
TrainingRegister may not to be provided write or change access to the SQL Server
database outside TrainingRegister tools.
Change Tracking Exceptions
Changes to the ProgramRequirements table are not logged. Changes linking a program to
a class or a person are logged. Data in the ProgramRequirements table is computed from
other data and is not directly edited by users.
If a ClassID is changed, the change to the ClassCatalog record is logged. This change is
replicated in many other related tables. The ClassID change in the related tables is not
logged.
If a person’s ID is changed, the change to the People record is logged. This change is
replicated in many other related tables. The ID change in the related tables is not logged.
Some actions such as importing employee data with the built- in import utility will record
the last import date in the Setup table. Software upgrades also make note in the Setup
table. These changes are not tracked.
If times or dates are changed for a scheduled class, the change to the ClassSchedule
record are logged. These changes are replicated to enrollment and scheduling records for
Rooms, Resources, Instructors and Students. Time and Date cha nges in the related tables
are not tracked.
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Security Settings
General
In the People Table, locate the person to whom you want to assign a right. Select the
[Security] tab. Click [Edit] and check the appropriate rights/privileges and then click
[Save]. "AllRights – Training Administrator" is number (2) on this page.
Automatic Login with Network Login Name
When first starting TrainingRegister it will attempt to log you in with your Network
Login Name or the name you used to login to your computer. This is also known as
NTLM Authentication.
If TrainingRegister can match your network login name with your record in the People
table you will be logged in automatically. If two or more people have the same login
name the login will fail with an explanation.
For this feature to function, the network login name must be entered in the appropriate
field near the bottom of the Security tab on the People form. You can select [Who Am
I?] from the [File] menu to see if TrainingRegister recognizes you.
Be sure to Logout or Close TrainingRegister to prevent other users from making
database changes using your security settings.
Security Tab Descriptions
Pswd – This password along with the user’s ID is required for manual login to the
Administration or Web Module. By default, a user with no additional rights can see their
own records and the training schedule when using the Web Module.
2) All Rights - Permits access to everything. Recommended only for one or two people.
3) Access Security Tab - Permits access to the [Security] tab on the People form.
4) View All People - Permits access to all People records via the Web Module. If
checked, will disable Supervisor filtering.
5) Add/Edit People - Permits using the [Edit] and [New] buttons on the People form.
6) Delete People - Permits using the [Delete] button on the People form.
7) View All Companies - Permits using the [Find] button on the Companies form.
8) Add/Edit Companies - Permits using the [Edit] and [New] buttons on the Companies
form.
9) Delete Companies - Permits using the [Delete] button on the Companies form.

40

10) View All ClassCatalog - Permits using the [Find] button on the ClassCatalog form.
11) Add/Edit ClassCatalog - Permits using the [Edit] and [New] buttons on the
ClassCatalog form.
12) Delete ClassCatalog - Permits using the [Delete] button on the ClassCatalog form.
13) View All ClassSchedule - Permits using the [Find] button on the ClassSchedule form.
14) Add/Edit ClassSchedule - Permits using the [Edit] and [New] buttons on the
ClassSchedule form.
15) Delete ClassSchedule - Permits using the [Delete] button on the ClassSchedule form.
16) Add/Edit/Delete People Related List Boxes - Permits access to the Relationships,
Divisions, Departments, Groups, Jobs, Shifts, Ranks, Races, Classify1, Classify2 and
Classify3 tables.
17) Add/Edit/Delete Company Related List Boxes - Permits access to the
CompanyGroups table.
18) Add/Edit/Delete ClassCatalog Related List Boxes - Permits access to the
DeliveryMethods, ClassGroupings and SubjectCategories tables.
19) Add/Edit/Delete ClassSchedule Related List Boxes - Permits access to the Resources,
Rooms and Reasons tables.
20) Add/Edit/Delete Required Training Related List Boxes - Permits access to the
Programs and LicenseTypes tables.
21) Add/Edit/Delete Skill Tracking Related List Boxes - Permits access to the Skills and
SkillLevels tables.
22) Add/Edit/Delete Accounting Related List Boxes - Permits access to the AccountCodes
tables.
23) Add/Edit/Delete Training Records - Permits access to the TrainingRecords table and
[Edit TrainingRecords] button on [Tasks] tab of People form. This does not control
linking of people to classes, enrollment or posting enrollment records.
24) Edit Software Settings and Options - Permits access to all Configuration Tables listed
under Global Options.
25) Access Import Utility - Permits access to Built- in Import Utility on [Tools] menu.
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26) Export Data - Permits using Export Data features on [Tools] menu.
27) System Administrator Options - Permits accessing System Administrator Options on
the [Tools] menu.
28) Permit Use of Create/Send Message Form - Permits access to the Messaging form.
29) Permit Enrolling People - Permits user to enroll people for scheduled training.
30) Permit Dropping People - Permits user to drop people from scheduled training.
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Appendix A - Definitions
AccountCode – Optional method of classifying people and their training records.
Maintained for compatibility with legacy data.
CEU – Continuing Education Unit. Earned credits toward a license or certification. Can
be different than Hours. The value earned can be defined for each License Type.
Change Tracking – This add-on feature tracks changes to the database. The login user
id, date, table name, field reference, old value, ne w value and whether the record was
edited, new or deleted are saved.
Class – Any training, learning experience or lesson. The smallest portion of training that
is tracked. Can be WBT, CBT, OJT, Self Taught or Instructor led. Permanent
information about a class is entered one time and is saved in the ClassCatalog table.
ClassGrouping – Optional method of classifying training. Scheduled classes can be
grouped by this classification on the web module. The ClassGroupings table contains the
definitions.
ClassID – User defined database key for the ClassCatalog table. Each record must have
a unique ClassID.
Companies – Name of a TrainingRegister table, which can contain training providers,
room providers, licensing agencies, resource providers, etc. If a multi- company license is
purchased then individuals in the People table and their training records can be classified
with a company from the Companies table.
DeliveryMethod – Optional method of classifying training. Example: Instructor led,
WBT, Self-Taught, On Job Training, Video, etc. The DeliveryMethods table contains the
definitions.
DepartmentID – Optional method of classifying people and their training records, and is
used in report selection. The Departments table contains the name of the department and
a link to the department level supervisor.
DivisionID – Optional method of classifying people and their training records, and is
used in report selection. The Divisions table contains the name of the division and a link
to the division level supervisor.
EmplNum – Optional place to store an employee number. In most cases the employee
number is used as the person’s ID and this field is not used.
GroupID – Optional method of classifying people and their training records, and is used
in report selection. The Groups table contains the name of the group and a link to the
group level supervisor.
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HireDate – Optional place to save an employment date.
Hours – The estimated or actual time required to receive training.
Inactive People – Can be excluded when searching for a person using the [Find] button
on the People form. When a person is classified as inactive, all their program
requirements are deleted. This keeps them off reports that indicate they need required
training. Their link to training programs remains. If the person is reclassified as active in
the future their program requirement records will be reconstructed.
JobID – Optional method of classifying people and their training records, and is used in
report selection. The Jobs table contains the name of the job.
List Box – An entry box, which limits user selection to predefined choices. Most all list
boxes in TrainingRegister are definable by the training administrator or a user with
sufficient user rights. A list box permits setting company policy for how training, people,
etc. will be classified.
People – Name of a TrainingRegister table, which can contain employees, students,
instructors, training administrators and contacts for records in the Companies table.
ProviderID – Optional method of classifying training with a company or school.
Providers are saved in the Companies table.
RankID – Optional method of classifying people and their training records, and is used
in report selection. The Ranks table contains the name of the rank.
Relationship – Optional method of classifying people, and is used in report selection.
The Relationship table contains the relationship definitions.
Revision – Optional method of classifying training (or document) with a revision
identificatio n. A new ClassCatalog record should be created for each new revision. A
replication feature is provided for this purpose.
Scheduled Class – A scheduled instance of a Class from the ClassCatalog table. Classes
can be scheduled many times. Scheduled Classes are saved in the ClassSchedule table.
Shift – Optional method of classifying people, and is used in report selection. The Shifts
table contains the shift definitions.
SubjectCategoryID – Optional method of classifying training. Scheduled classes can be
grouped by this classification on the web module. Names of people who have received
any training for a specific SubjectCatagoryID can be retrieved. The SubjectCategories
table contains the names of each subject.
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TermDate – Optional place to save a termination date.
Training Program – Also known as a course, track, path or curricula. In
TrainingRegister, a Training Program is a group of one or more classes in the
ClassCatalog table which are required by a group of one or more individuals in the
People table.
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Appendix B - Tab and Field Descriptions For
Tables
People Table Tabs and Field Descriptions
Use only the fields needed to accomplish the tasks and reports desired.
General Tab
ID: Required. Enter an Employee Number, Badge Number, or SSN to uniquely identify
the person. If the TrainingRegister Import Utility is used, this number must match the
number used in the HR or payroll system. Also, fake numbers should not be used if the
import utility is used.
First: Required. Enter a first na me or first initial and middle name as appropriate.
Mi: Can be use to enter a middle initial.
Last: Required. Enter a last name.
Inactive: Check this box to keep the person from appearing in most reports. When a
person is classified as inactive, all their program requirements are deleted. This keeps
them off reports that indicate they need required training. Their link to training programs
remains. If the person is reclassified as active in the future their program requirement
records will be reconstructed. NOTE: The import utility can mark this automatically.
Instructor: Check this box if the person is an instructor. This places them on a master
list of instructors.
Administrator: Check this box if the person is a training administrator who will “own”
one or more classes and will receive web based enrollment requests. Be sure to also
record an email address.
Supervisor: Check this box to if the person is a supervisor. Divisions, Departments and
Groups can be classified with a supervisor.
Immediate Supervisor: This field will display the current person’s immediate supervisor.
This field will be left blank if no supervisor has been specified or if the person is marked
as a supervisor.
Position: Can be used to enter a text description of job title or position. Generally, skip
this field and use the Job field to classify the employee.
DivisionID: Can be used to classify a division from the list box. This value will be saved
with the training records of this employee. Normally, a change will only affect future
training records.
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DeptID: Can be used to classify a department from the list box. This value will be saved
with the training records of this employee. Normally, a change will only affect future
training records.
GroupID: Can be used to classify a group from the list box. This value will be saved
with the training records of this employee. Normally, a change will only affect future
training records.
JobID: Can be used to classify a job from the list box. This value will be saved with the
training records of this employee. Normally, a change will only affect future training
records.
RankID: Can be used to classify a rank from the list box. Choices are added from the
[Tables] menu. This value will be saved with the training records of this employee.
Normally, a change will only affect future training records.
Relationship: Can be used to specify a relationship from the list box. This is where you
can define the person’s relationship to your company, i.e. Employee, Student, Instructor,
etc.
Shift: Can be used to specify a shift from the list box. Choices are added from the
[Tables] menu.
EmplNum: Generally skip this field and use the Employee Number as the ID. Enter an
Employee Number if not used for the ID and it is needed. The label for this field can be
modified for custom usage or marked “N/A” if not used.
AccountCode: Generally skip this field. This field has been retained for compatibility
with legacy client data.
HireDate: Can be used to enter the hire date for the employee. The number for the right
of this field indicates the number of years the person has been employed. This number
will only be displayed if a date has been entered in the HireDate field.
TermDate: Can be used to enter the termination date for the employee.
Contact Tab
Company: This field has been retained for compatibility with legacy client data. If
multi-company license has been purchased, skip this field and use the drop-down list box
titled CompanyID at the top of the Contact Tab to classify people by their companies.
Address, MailStop, City, StateProvince, PostalCode, Country: Enter as needed or desired
for mailing address.
BusPhone, Ext: Can be used to enter business phone and extension.
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HomePhone: Can be used to enter a home phone.
Mobile: Can be used to enter a cell or digital phone number.
Fax: Can be used to enter a fax number.
Pager: Can be used to enter a pager number.
E_Mail: Can be used to enter an email address.
Misc Tab
Classify1: Can be used for customized classifications. Enter a selection from the list box.
The label for this field can be modified for custom usage or marked “N/A” if not used.
Classify2: Can be used for customized classifications. Enter a selection from the list box.
The label for this field can be modified for custom usage or marked “N/A” if not used.
Classify3: Can be used for customized classifications. Enter a selection from the list box.
The label for this field can be modified for custom usage or marked “N/A” if not used.
Misc: Accepts 60 characters.
DOB: Can be used to enter a date of birth. Recorded with the history for affirmative
action reporting and sometimes used with license tracking.
Gender: Can be used to enter “M”, “F” or “U”. Recorded with the history for
affirmative action reporting.
Race: Can be used to select a race from the list box. Recorded with the history for
affirmative action reporting.
PreferredReportLanguage: The default language is English. If Spanish is selected, a
few reports will be displayed in Spanish, i.e. the confirmation letter.
NewRecord: Displays date of record creation.
Updated: Displays date record was last saved.
Notes Tab
Notes: Can be used to enter general comments about the employee. Text can be prepared
and spell checked in a word processor and then pasted in this field by using CTRL+V or
[Edit], [Paste].
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Dev Plan Tab
Dev Plan: Can be used to enter comments about the employee’s personal development
plan. Text can be prepared and spell checked in a word processor and then pasted in this
field by using CTRL+V or [Edit], [Paste].
Security Tab
The security tab is where the security settings for an individual may be found. A user’s
password can be reset from this tab. A network login name can also be defined in the
NTML_UserName field. See the section “Security Settings” for a description of each
security setting.
Reports Tab
The Reports tab is where some of the reports for the current person are located. All
Reports can be found under the Reports Menu at the top of Training Register.
Tasks Tab
The Tasks tab is where functions for the current person can be performed.

Companies Table Tabs and Field Descriptions
Use only the fields needed to accomplish the tasks and reports desired.
General Tab
CompanyID: Required. Enter a number to uniquely identify the company.
CompanyName: Required. Enter the name of the company.
CompanyGroup: Can be used to classify company records.
ClientCompany: Reserved for future use.
RoomProvider: Place a check in this box if this company provides rooms for the classes
offered in the class catalog. Records in the rooms table can be classified with a room
provider.
ResourceProvider: Place a check in this box if this company provides resources for the
classes offered in the class catalog. Records in the resource table can be classified with a
resource provider.
SupportProvider: Reserved for future use.
LicensingAuthority: Reserved for future use.
TrainingProvider: Place a check in this box if this company provides training for people
in your database. Records in the ClassCatalog table can be classified with a provider.
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Website: Can be used to enter the companies website address.
City, StateProvince: Information from these fields may be used to specify company
location in some reports.
Notes Tab
Notes: Can be used to enter general comments about the company. Text can be prepared
and spell checked in a word processor and then pasted in this field by using CTRL+V or
[Edit], [Paste].
Reports Tab
The Reports tab is where some of the reports for the current company are located. All
Reports can be found under the Reports Menu at the top of Training Register.
Tasks Tab
The Tasks tab is where functions for the current company can be performed.

ClassCatalog Tabs and Field Descriptions
The ClassID field is designed to accept a unique user defined alphanumeric identifier for
each training class. The ClassID should not be changed after the class record has been
scheduled or used for historical records. The ClassID is replicated into the training
history and scheduling tables. The ClassID is the database key for the ClassCatalog and
cannot be modified.
By default, the ClassID cannot be modified. This recommended setting can be changed
in the System Administrator Options.
General Tab
Title: Required. Enter a descriptive name for the training.
Revision: Can be used for ISO document revision identifier. This field should not be
changed. Instead, replicate the class record and give the new class record a different
revision identifier.
Hours: Required. Enter the actual number of clock hours for the training. Decimals are
accepted.
CEU: Can be used to enter the number of continuing education units or re- licensing
credits. Decimals are accepted.
Days: Can be used to enter the number of days of the duration of the class.
Delivery Method: Can be used to select the method of delivery for the class.
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Class Grouping: Can be used to select a class grouping. This is an optional method of
classifying training. Scheduled classes can be grouped by this classification on the web
module. The ClassGroupings table contains the definitions.
Subject Category ID: Can be used to select a subject category ID. This is an optional
method of classifying training. Scheduled classes can be grouped by this classification
on the web module. Names of people who have received any training for a specific
SubjectCatagoryID can be retrieved. The SubjectCategories table contains the names of
each subject.
Provider ID: Can be used to select a provider ID. This is an optional method of
classifying training with a company or school. Providers are saved in the Companies
table.
Cost: Value only used if training records are created by directly linking people to this
class and the enrollment process is bypassed. This value should be the actual cost per
student and not the total class cost.
Inactive: Can be used to enter the date the class is no longer offered or is obsolete. Class
records should never be deleted as that would delete the permanent historical training
records of all participants.
Description Tab
Description: Can be used to enter a brief description, abstract and/or prerequisites. The
entry should be valid for all scheduled offerings of this class and not contain scheduling
data. Because this text will need to wrap differently in different reports and browser
settings, please enter only plain text without formatting. Text can be prepared and spell
checked in a word processor and then pasted in this field.
Misc Tab
InstructorID: This field is used only for recording old historical training when it is
necessary to document the instructor. The instructor’s ID will be recorded in the history
file when bypassing the scheduling procedures and linking people directly to a class. In
most cases, this field will not be used.
AdministratorID: Can be used to select a training administrator who will “own” this
class and receive web based enrollment requests. The list box displays the employee
records that are classified as Administrator with a check box.
Interactive Tab
ConfirmationHeader: Can be used to customize the Enrollment Confirmation Letter and
can be entered in the corresponding boxes for either English or Spanish.
ConfirmationFooter: Can be used to customize the Enrollment Confirmation Letter and
can be entered in the corresponding boxes for either English or Spanish.
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Reports Tab
The Reports tab is where some of the reports for the class are located. All Reports can be
found under the Reports Menu at the top of Training Register.
Tasks Tab
The Tasks tab is where functions for the class can be performed.

ClassSchedule Tabs and Field Descriptions
General Tab
ProviderID: The default provider, as defined in the Class Catalog, will appear in this
field. Change only if the provider for this scheduled instance is not the same as the
regular provider listed in the ClassCatalog.
ClassBegin: Required. Enter a beginning date and time for the class.
ClassEnd: Required. Enter an ending date and time for the class.
StudentMin: Can be used to enter the minimum number of students needed for the class.
This can be used in making the decision for canceling a class.
StudentMax: Can be used to enter the maximum number of students allowable for the
class. The number of enrollments are limited to this value.
CancelDate: If a date is entered, students are requested to drop the class on or before this
date.
DisplayOnWeb Feature: When checked, the TrainingRegister Web Module can
display this class with other scheduled classes.
Logistics Tab
Logistics: Can be used to record information for Training Administrator, Coordinator, or
Instructor use. This information is not displayed on the class schedule for student
viewing.
Misc Tab
FYI Only: Except for the ClassScheduleID, these values are inherited from the
ClassCatalog at the time the class is scheduled and provide different ways of searching
and sorting scheduled classes. Some field values are inherited by the training records that
are created when enrolling a person.
ClassGrouping: Used to group, sort and filter Scheduled Classes on the Web Module.
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Tuition: Currently, Tuition is printed on the confirmation letter if so configured.
TrainingRegister® does not contain revenue tracking or billing features at this time.
These features might be available for added cost in the future.
Reports Tab
The Reports tab is where some of the reports for the current class are located. All
Reports can be found under the Reports Menu at the top of Training Register.
Tasks Tab
The Tasks tab is where functions for the current class can be performed.
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Appendix C - Reports
People Related Reports
List of People
Produces a Report displaying a list of people based on the search criteria given.
List of Supervisors
Produces a Report displaying a list of supervisors based on the search criteria given.
List of Training Administrators
Produces a Report displaying a list of training administrators based on the search criteria
given.
List of Instructors
Produces a Report displaying a list of instructors based on the search criteria given.
Schedule for a Selected Person – Simple
Produces a report only based on BeginDate, EndDate, and Class Description and shows
all the classes a selected individual is scheduled to attend or instruct.
Schedule for a Selected Person – with Detail
Produces a report based on the search criteria given that shows all the classes a selected
individual is scheduled to attend or instruct.
Training Records for a Selected Person
Produces a report based on the search criteria given that shows completed classes and
classes a person is enrolled for or instructing.
Training Records for a Selected Person by SubjectCategory
Produces a report based on the search criteria given that shows completed classes and
classes a person is enrolled for or instructing sorted by SubjectCategory.
Training Records for a Selected Person by ClassGrouping
Produces a report based on the search criteria given that shows completed classes and
classes a person is enrolled for or instructing sorted by ClassGrouping.
Training Records for a Selected Person by Delivery Method
Produces a report based on the search criteria given that shows completed classes and
classes a person is enrolled for or instructing sorted by DeliveryMethod.
Training Program Requirements for a Selected Person – with Detail
Produces a report based on the search criteria given that shows all the required classes for
all of the programs a selected person is linked to. The report also contains information
regarding TargetDate, date completed, the interval that the class is needed, and when the
required class is next due.
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Training Program Requirements for a Selected Person – Summary
Produces a report based on the search criteria given that shows only the needed required
classes for all of the programs a selected person is linked to. The report also contains
information regarding TargetDate, date completed, the interval that the class is needed,
and when the required class is next due.
Duplicate Confirmation Letter for a Selected Person
Produces a report based on the search criteria given that duplicates the confirmation letter
that was generated when a student is enrolled in a scheduled class.
List of Skills for a Selected Person
Produces a report based on the search criteria given that shows all the skills a selected
person is linked to.
Missed Training for a Selected Person
Produces a report based on the search criteria given that shows the classes a selected
person has missed or dropped, the date of the class, and the reason why the class was
missed.
Completion Certificates Merge File for a Selected Person and Class
Produces a merge file that can be used with a word processor to create Completion
Certificates to your own specification and design. This particular merge file will be
created from one training record for a specific person. It is useful to produce a single
Completion Certificate.

ClassCatalog Related Reports
Class Catalog – List of Selected Training / Classes
Produces a report that shows a list of training and classes based on the search criteria
given.
Master List of Instructors
Produces a report based on the search criteria given that shows a master list of people
who are designated instructors.
Master List of Instructors with Classes
Produces a report based on the search criteria given that shows a master list of instructors
along with the classes they are qualified to teach.
Scheduled Dates / Times for a Selected Class
Produces a report based on the search criteria given that shows the dates and times a
selected class is scheduled.
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Waitlist for a Selected Class
Produces a report based on the search criteria given that shows a prioritized list of people
who are is on a waitlist for a selected class.
Linked Prerequisites for Selected Class
Produces a report based on the search criteria given that shows the linked prerequisites
for a selected class.
List of Classes with Prerequisites
Produces a report based on the search criteria given that shows the a list of classes with
prerequisites.
Completed Training / Historical Roster for a Selected Class
Produces a report based on the search criteria given that shows who all has completed a
selected class and the date which it was completed.
Historical Class Dates for a Selected Class
Produces a report based on the search criteria given that shows dates a selected class has
been given.
Qualified Instructors for a Selected Class
Produces a report based on the search criteria given that shows the people who have been
designated qualified instructors for a selected class.
Missed Training for a Selected Class
Produces a report based on the search criteria given that shows who has missed or
dropped a selected class, the date of the missed class, and the reason why the class was
missed.
Completion Certificates Merge File for Selected Class
Produces a merge file that can be used with a word processor to create Completion
Certificates to your own specification and design. This particular merge file will be
created from one training record for a specific person. It is useful to produce Completion
Certificates for a roster of people who completed the training on the same day.

ClassSchedule Related Reports
Scheduled Classes – List
Produces a report based on the search criteria given that shows scheduled training.
Training Calendar
Produces a Calendar based on the search criteria given that shows scheduled training for
a selected amount of time. The report can be filtered for a ClassGrouping, Provider,
SubjectCategory, or a specific class.
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Enrollment Roster / Custom Sign In Sheet
Produces a report that shows who all is enrolled in a selected class which can also be
used as a sign in sheet.
Class Expense / Cost Summary
Produces a report that shows credits and debits associated with a selected class.
Scheduled Class Details
Produces a report based on search criteria given that shows information regarding a
scheduled class.
Duplicate Confirmation Letter
Produces a report based on the search criteria given that duplicates the confirmation letter
that was generated when a student is enrolled in a scheduled class.
Completion Certificates Merge File for Selected Scheduled Class
Produces a merge file that can be used with a word processor to create Completion
Certificates to your own specification and design. This particular merge file will be
created from one training record for a specific person. It is useful to produce Completion
Certificates for a roster of people who are enrolled in the same scheduled class and will
be completing training on the same day. Because the training ha s not yet been
completed, the merge data will not contain a value for hours or a completion date.

Required / Needed Training Related Reports
All Required Classes
Produces a report based on the search criteria given that shows a list of all classes that are
designated “required”.
All Required Classes Grouped by Training Program
Produces a report based on the search criteria given that shows a list of all classes that are
designated “required” and sorts them by training program.
Required Classes for a Selected Program
Produces a report based on the search criteria given that shows a list of classes that are
designated “required” for a selected program.
People Linked to a Selected Program
Produces a report based on the search criteria given that shows a list of people that are
linked to a selected program.
Needed Classes – Prioritized List
Produces a report based on the search criteria given that shows a list of the classes that
people need and sorts them by how many people need the class.
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People who need a Selected Class
Produces a report based on the search criteria given that shows the people who need a
selected class.
Linked Programs for a Selected Class
Produces a report based on the search criteria given that shows the programs to which a
selected class is linked.
Requirements / Needs for a Selected Person
Produces a report based on the search criteria given that shows all the required classes for
all of the programs a selected person is linked to. The report also contains information
regarding Ta rgetDate, date completed, the interval that the class is needed, and when the
required class is next due.
Requirements / Needs for a Selected Person – Summary
Produces a report based on the search criteria given that shows only the needed required
classes for all of the programs a selected person is linked to. The report also contains
information regarding TargetDate, date completed, the interval that the class is needed,
and when the required class is next due.
Delinquency Report – Summarized by Division
Produces a report based on the search criteria showing summarized delinquency statistics
categorized by divisions.
Delinquency Report – Summarized by Department
Produces a report based on the search criteria showing summarized delinquency statistics
categorized by departments.
Delinquency Report – Summarized by Group
Produces a report based on the search criteria showing summarized delinquency statistics
categorized by groups.
Delinquency Report – Grouped by Division
Produces a report based on the search criteria showing complete delinquency statistics
grouped by divisions.
Delinquency Report – Grouped by Department
Produces a report based on the search criteria showing complete delinquency statistics
grouped by departments.
Delinquency Report – Grouped by Employee Group
Produces a report based on the search criteria showing complete delinquency statistics
grouped by employee groups.
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Skill Tracking Reports
People with a Specific Skill
Produces a report based on the search criteria given that shows the people who are linked
to a specific skill.
Skills for a Selected Person
Produces a report based on the search criteria given that shows all the skills to which a
selected person is linked.

List Boxes – Contents of
From the [Reports] menu, a person can produce a report that shows what all is in a
specific list box. To actually modify the list box, go to [Tables], then choose [List Box
tables] and then choose the list box you want to modify.
People Related List Boxes
Relationships
Divisions
Departments
EmployeeGroups
Jobs
Shifts
Ranks
Races
Classify1
Classify2
Classify3
Supervisors
Training Administrators
Instructors – Master List
Company Related List Boxes
CompanyGroups
ClassCatalog Related List Boxes
DeliveryMethods
ClassGroupings
SubjectCategories
Providers
ClassSchedule Related List Boxes
Resources
Rooms
Reasons

59

Required Training Related List Boxes
Programs - (Training Programs)
Skill Tracking Related List Boxes
Skills
Skill Levels
Accounting Related List Boxes
AccountNumbers – Chart of Accounts

Training Records – Other
Training Records – All Classes, Selected People, Date Range
The purpose of this report is to provide a method of extracting selected training records
from the database. Data displayed in the table can be copied to the Windows clipboard
and then pasted into an empty Excel spreadsheet.
Training Records – Tagged Classes, All People, Date Range
The purpose of this report is to provide a method of extracting selected training records
from the database. Data displayed in the table can be copied to the Windows clipboard
and then pasted into an empty Excel spreadsheet.
Training Records – All Classes, Tagged People, Date Range
The purpose of this report is to provide a method of extracting selected training records
from the database. Data displayed in the table can be copied to the Windows clipboard
and then pasted into an empty Excel spreadsheet.

Security Reports
Login Users by Rights
This report includes only people who have one or more check boxes checked on their
Security tab. These are the training administrators, training coordinators and maybe
supervisors who will be using the Administration Module. The Administration Module is
not designed for students. The Web Module is designed for students. It also makes use of
some of the check boxes on the Security tab to grant additional rights to supervisors. See
the documentation for details because not all of the check boxes will affect the Web
Module functionality. The default level of security (no check boxes checked) will permit
a person (student) to see their own records and requirements, and access the list of
scheduled training when using the Web Module.
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Appendix D – List Boxes
People Related List Boxes
Relationships
Use this form to define Relationships for use in classifying individuals in the People
table. Relationships can help separate Employees, Vendors, Students, Clients, etc.
Divisions
Use this form to define Divisions for use in classifying employees in the People table. If
a person is classified with a Division at the time they receive training, the Division
classification will be saved in their training records. The Division is also a way to link a
supervisor to his/her employees. A filter can be used to permit a supervisor to see only
the records of his/he r employees.
Departments
Use this form to define Departments for use in classifying employees in the People table.
If a person is classified with a Department at the time they receive training, the
department classification will be saved in their training records. The Department is also a
way to link a supervisor to his/her employees. A filter can be used to permit a supervisor
to see only the records of his/her employees. You can also designate a parent Division to
the specific Department. A department name and ID are required when defining a new
department.
Groups
Use this form to define Groups for use in classifying employees in the People table. If a
person is classified with a group at the time they receive training, the group classification
will be saved in their training records. The group is also a way to link a supervisor to
his/her employees. A filter can be used to permit a supervisor to see only the records of
his/her employees. You can also designate a parent division to the specific department.
Jobs
Use this form to define Jobs for use in classifying employees in the People table. If a
person is classified with a job at the time they receive training, the job classification will
be saved in their training records.
Shifts
Use this form to define Shifts for classification of employees in the People table. Shifts
can be used in searching the People table.
Ranks
Use this form to define Ranks for use in classifying employees in the People table. If a
person is classified with a Rank at the time they receive training, the rank classification
will be saved in their training records.
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Races
Use this form to define Races that can be used to classify individuals in the People table.
If a person is classified with a Race at the time they receive training, the race
classification will be saved in their training records. We recommend that you only use
this classification if you are required to produce affirmative action data from your
training records. Sex and age classifications are also provided if needed for the same
purpose.
Classify1, Classify2, Classify3
Use these forms to build a user defined classification for People when no other
classification is suited to the need. These three are provided in list box format. It may be
a good idea to discuss special needs with the vendor.
Supervisors
See the people Table. A person is classified as a Supervisor by checking the Supervisor
checkbox on his/her record. A report listing all Supervisors is available on the Reports
Menu.
Training Administrators
See the people Table. A person is classified as a Training Administrator by checking the
Training Administrator checkbox on his/her record. A report listing all Training
Administrators is available on the Reports Menu.
Instructors
See the people Table. A person is classified as an instructor by checking the Instructor
checkbox on his/her record. A report listing all instructors is available on the Reports
Menu.

Company Related List Boxes
CompanyGroups
Use this form to define classifications for Company Records in the Companies tables.

ClassCatalog Related List Boxes
DeliveryMethods
Use this form to define training delivery methods such as CBT, Video, Instructor Led,
Self-Study, etc. Classes in the ClassCatalog table can be classified with a Delivery
Method. This classification is also saved in the training records of those who receive the
training.
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ClassGroupings
Use ClassGroupings to classify records in the ClassCatalog table. Then scheduled
training and historical training can be reported and/or grouped by ClassGrouping.
SubjectCategory is used in the same way.
SubjectCategories
Use SubjectCategories to classify records in the ClassCatalog table. Then scheduled
training and historical training can be reported and/or grouped by Sub jectCategory.
ClassGrouping is used in the same way. The TrainingRecords table can also be searched
for people who have received specific subjects or knowledge.
Providers
See the Companies Table. A company or an organization is classified as Training
Provider by checking the checkbox on the company’s record. A report listing all
Providers is available on the Reports menu. One Provider can be designated the Default
Provider in the Global Options section in the Configuration Tables. That provider will
then be used each time a new record in the ClassCatalog is created.

ClassSchedule Related List Boxes
Resources
Use this form to build an inventory of Resources that can be scheduled with scheduled
training.
Rooms
Use this form to build an inventory of training Rooms. These can be internal and/or
external. These are only needed if you want to schedule the room with training and/or
you want the confirmation letters and individual training schedules to display the room
and directions.
Reasons (for dropping class)
Use this form to build a list of potential reasons a student would drop a class. When a
student is dropped from a scheduled class, the user will be prompted to select a Reason
from a list box.

Required Training Related List boxes
Programs
Training Programs are used to define required training. A training program is similar to a
track, path, or curricula. Use this form to define Training Program names. Later,
Programs will be linked to both people and classes to define who is required to receive
specific training.

63

Skill Tracking Related List Boxes
Skills
Use this form to create Skills, which can be linked to individuals in the People table.
TrainingRegister® does not relate skills to training. Skills are an independent method of
classifying people. A person could be linked to a skill after completing training and/or
demonstrating proficiency. A report provides an easy method of searching for people
who have a specific skill.
Skill Levels
Use this form to create Skill Levels, such as novice, expert, apprentice, level1, and level2.
These can be used when linking a person to a Skill. The Skill Level is an alphanumeric
field.

Accounting Related List Boxes
AccountNumbers
Use this form to build a list of Account Numbers (Chart of Accounts) and associated
descriptions. AccountNumbers will be selected from a drop-down list box and are
required when recording financial transactions.
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